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You will need to download
the following files from the
glitterguru on Photoshop web
site to complete this project:

chapter6_1.tif

chapter6_2.tif

chapter6_3.tif
chapter6_4.tif
chaptero_5.tif
chapter6_o6.tif
chapter6_7.tif

chapter6_8.tif
chapter6_9.tif
chapter6_10.tif
chaptero_11.tif
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Disclaimer

I want to preface this section with a disclaimer. All the women in this
chapter are perfect before I touch a pixel. They are smart, charismatic,

and incredibly beautiful inside and out. These gorgeous women are human,
however, and that is no longer acceptable in today’s beauty and fashion
world. T am asked to make them superhuman, perfect beyond reality. On the
upside, I do love to make beautiful women into super-beautiful women, and
that’s important because retouching is often the meat and potatoes of the
jobs I do.

Styles of Retouching

I like to think of retouching techniques as falling into three different styles
or categories: reality retouching, plastic surgery, and fantasy. These cate-
gories serve an artistic purpose. By establishing a goal for the ultimate
look and feel of the image, they provide the parameters that decide the
range of techniques I’'m willing to use and give me the boundaries for

the job at hand.

As I’ve mentioned in previous chapters, it’s very important to have a concept
of where you’re trying to go before you start working. This is especially true
for retouching—you don’t want to just go in and start hacking away!
Deciding in advance what kind of style you’re aiming for will keep your
work focused and help you produce a more unified final image.

These categories also prove quite helpful when working with clients. You
can show them the range of possibilities, including before and after images
to illustrate each style, to give them an idea of what they can expect to see
when you’re done. This helps ensure the client will understand the process
and be satisfied with the end result.

If your portfolio doesn’t have examples of all the different styles in it, you
can use examples from magazines to get across the different possibilities.
I suggest trying to incorporate these different styles into your portfolio,
however, because it will help you broaden your client base and give you
more work opportunities.



Reality Retouching

Reality retouching is the kind of retouching you do when the client doesn’t
want anyone to know that you have altered the image. I find this style of
retouching the most challenging, because there is an art to having your
work go completely unnoticed. When doing this style of retouching, we
usually don’t remove every wrinkle, but instead just make the subject more
attractive. What do I mean by “more attractive”? Well, it’s subjective, but I

like to concentrate on the idea of removing what’s distracting me from the ( Reality retouching
. . . . see Im f
person ’'m retouching. In real life we are animated, and this makes those otepin 5:3: ) n: also the first,
. . . . . . . ouching for g |ap,
little lines and spots much less noticeable. In fact, the little imperfections, Maority of my images, h:ge

establishes 5 £,

as part of a real-live person, can add character and charm. When you freeze
Which to do fapt

undatiOn upon

. . . 5 as A
a moment in time and give the eye a chance to concentrate on these minor Y retouching

and plastic Surgery,

imperfections, however, they become more pronounced. This is where
reality retouching comes in. The idea is to do the minimal amount of work
necessary to lessen those slight imperfections. Among the things that you’ll
want to work on are blemishes that need removing, deep wrinkles that need

softening, tired eyes that need whitening, and yellow teeth that need to
be brightened.

1 Before and after images showing
reality retouching.
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Plastic Surgery

Another category of retouching is plastic surgery. This is where you really
transform the person, perhaps even removing years from the person’s face,
by lifting and altering her features. Plastic surgery can involve drastic
changes: nose jobs, eye-lifts, liposuction, and hair extensions. However,

the goal is still to achieve the desired result without making the person look

completely unrealistic.

2 Before and after images showing a plastic surgery eye-lift.
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5 Before and after images showing a plastic surgery nose job.
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Fantasy Retouching

The final category I use is fantasy retouching. This is where things start to
get a little surreal. With a fantasy retouch, you’re no longer trying to imitate
reality or conceal your work. In fact, the effect you create will become an
integral artistic component of the whole image, and almost anyone looking
at the image will immediately realize that it has been artificially enhanced.

Many times, when you retouch this intensely, you almost turn the model
into a painted figure. When you do this, you’ll probably want to extend this
look out to the whole image, creating a dreamy surreal quality so that the
retouched model still looks as though she fits into her surroundings. As
you’ll see later, this kind of effect can be achieved in an image by playing

with light, color, or focus.

4 Before and after images
showing fantasy retouching.

AVOIDING BEGINNERS’ MISTAKES

A few things jump out when | see a bad
retouching job. First and foremost is
when | see a face on which parts of the
skin have been retouched and other
parts haven’t. Also, remember your
edges! The edges of anything are key to
making something look “right”; so if you
blur the edge of a lip line too much
while retouching, it will look wrong.
Working evenly and paying attention to
your edges will keep you from making
beginners’ mistakes.
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This chapter will give examples of each of the three categories I’ve defined.

As usual, you can find the images used in this chapter on the web site, so
you can try things out for yourself.

This discussion starts first with reality retouching, which is not only
a useful technique in and of itself, but forms the basis for the more
advanced styles.

Reality Retouching

Reality retouching should be invisible. Your mission is to be as stealthy as
possible—get in and out without being detected. You will probably not
receive any credit for this mission because nobody’s supposed to know
about it. You, your client, and your team (if any) are the only ones who
will receive the quiet satisfaction of a job well done.

For the first example, consider an image that was designed as a point
of purchase (POP) display for Reflexxions. As is typical with makeup
companies, the client wants the girl in the display to look as natural as

possible, while still being “perfect”—definitely a job for reality retouching.

5 An example of reality retouching.
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Assessing the Image

It’s important to start by assessing the image as a whole, and deciding more
or less what you want to do beforehand. Working with the image on the
screen, make notes of the areas that need to be changed. By taking the time
to do this assessment before “jumping right in,” you will develop a clearer
mental image of the final product. This will keep you from over- or under-
doing any one area and will help you produce a better-balanced final image.
It’s a good idea to have a mental checklist that you go over when assessing
the image. Here’s an example check list:

¢ Overall skin (including forehead, nose, cheeks, chin, and jaw)
€ Smooth the texture, remove bumps or major wrinkles.
<2 Even out the color, conceal and blend blemishes or
uneven makeup.
¢ Remove any unwanted shininess.
<€ Hair
¢ Eliminate any fly-aways.
< Fill in gaps.
¢ Fix color on roots.
¢ Eyebrows
¢ Check overall shape. Reshape if necessary.
¢ Corral any loose or wild hairs.
¢ Divide unibrow.

€2 Eyes
¢ Brighten whites of eyes.
¢¢ Check for and remove mascara clumps.
¢ Check for crow’s feet, and blend away as needed.
¢ Soften under-eye circles.
€ Remove unwanted or distracting catch lights.

€ Nose

¢ Even out or blend away unwanted shadows on sides of nose.
€2 Lips

¢ Check shape of lips. Define and reshape as necessary.

¢ Clean up bleeding lipstick.

¢ Clean up and even out highlights on lips.

¢ Teeth
¢ Whiten teeth.
¢ Correct slightly crooked teeth.

¢ Cheeks, chin, and jaw
¢ Lessen deep smile lines or wrinkles.
¢ Smooth evenness of blush on apple of cheek.

¢ Body parts (legs, arms, and so on)
€ Smooth tone and texture.
€ Improve contours of highlights and shadows.



As part of your assessment, decide what to leave and what to remove so
that the job is believable. Often art directors will give you specific guidelines
for what they’d like to see done. On this particular job, I worked closely
with the art director to decide what to remove and fix. Image 6 shows the
art director’s marks indicating the changes she wanted made. As you can see
from all the marks, there’s a lot of work to be done for something that’s
supposed to look natural!

After going over the raw image with the art director, I then begin the basics
of retouching.

Fill-in with hair

Remove halr

6 The marked-up image showing changes requested by the art director.
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Removing Wrinkles

Before you even think about touching your Tool palette, be sure to duplicate
your original layer. To do this, right-click the layer and select Duplicate
Layer. Name the layer model copy. Work on the copy layer, and leave your
original layer untouched. That way you will always have a copy to go back
to for reference. I usually begin by using the Healing Brush tool to remove
small wrinkles and any stray hairs that may have moved over the face

during the shoot.

7 Removing the forehead wrinkle using a small brush.

Start by choosing a brush just big enough to cover the area that needs to be
eliminated. You can use the left and right bracket keys ([ and ]) to reduce or
increase the brush size.

For the type of wrinkle shown here, which is small and very linear, click one
end of the wrinkle, hold down the Shift key (which makes the tool work in
a straight line), and click to the end of that wrinkle line. You also can use
small short strokes with the tool to accomplish the same effect.

Next, using the same technique, work on any stray hairs covering the face.
Continue this process until you have eliminated all of these fine lines, hairs,
and wrinkles.



Flawless Skin

I like to retouch in a little different way than most people. I discovered,
when I started looking through the different channels to find out where all
the garbage was hidden, that generally speaking on Caucasian models the
“junk” can be seen more readily in the Green channel. (For other ethnicities,
it may be seen more readily through one of the other channels.) To highlight
those bad areas that I need to concentrate on, I open a window (Window >
Documents > New Window) with a view of the Green channel, in addition
to my view of the full-color version. As you can see in the image, this Green
channel view helps you to see those areas of rough skin texture more easily.
Note that in the Green channel window, even though you’re only looking at
the Green channel, you want all the channels to be active. Otherwise, when
you retouch, you’ll be painting in the color green only. Active channels
appear highlighted in the Channels palette as seen in Image 10.

To activate all channels while viewing only the Green channel, go to the
Channels palette and click the RGB channel. Then click the eye icons
next to the RGB, Red, and Blue channels to hide them.

All the colors you
can see oh your
screen are created
by mixing different
amounts of the three
primary colors: red,
green, and blue. For
example, mixing red and
green together produces
colors such as orange,
yellow, and brown.

Photoshop stores the color
information of your image by

keeping track of how much red,

green, and blue to use for every

pixel. Normally, Photoshop auto-

matically mixes the red, green, and
blue together for you and displays

the result. There is, however, a way to
view the individual colors separately,
before they are mixed, using what are

called color channels. To view the different
channels of an image, go to the Window
menu and select Channels. (The Channels
palette will display.) You will see (for a normal
color image) four channels: one called RGB,
which contains the mixture of all three colors;
and one each for Red, Green, and Blue, which

contains just the information about how much

= E

10 The Channels palette,
showing the setup for
retouching while viewing
the Green channel.

red, green, or blue is used at a specific spot.

You can view one channel at a time by clicking it in
the Channels palette. Color channels can prove very
useful for retouching because, when viewed in iso-

11 Window setup for retouching.

lation, they can highlight subtle details that

might be harder to spot in the full-color image.
In the retouching examples here, | use the
Green channel to help visualize areas where
the texture of the model’s skin needs to be

smoothed.

Note: There are other systems besides
the three-color RGB mode for keeping
track of color information in an image.

The CMYK system (for cyan, magenta,
yellow, and black) is commonly used
when preparing images for four-color

printing and has four channels of
color rather than three.

9 The Channels
palette in its
default state.
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Next, make a layer (Ctrl+Shift+N) and call it retouching. This layer is
where you’ll do the work of smoothing the skin and making it flawless. Up
until now, you’ve been using the Healing Brush. For the next step, however,
switch to the Clone Stamp tool. The Healing Brush is great for creating
repairs without disturbing texture and tone. At this stage, however, you
want to disturb the texture and tone. That is why you will be using the
Clone Stamp to smooth and even out the skin. After you’ve selected

the Clone Stamp tool, go to the Options settings and select an Opacity
setting of between 20% and 30%. Also, make sure the Use All Layers
option is checked. The basic approach is to use the Clone Stamp like an air-
brush. For open areas such as the forehead, use a large brush size of about
100 pixels, going down to a smaller 60-pixel brush for more detailed work.

Working in the Green channel window, clone onto areas that need smooth-
ing from adjacent areas of similar surface texture and color tone. This
requires a bit of practice until you get the “feel” of it, but it basically comes
down to blending the tones and smoothing the texture—all the textures
and tones need to match and smoothly blend together. Remember, you are
creating a layer that will be superimposed over the original, so don’t be
afraid of being too heavy handed. You will need to push some pixels around
(be nice) to get the desired results. This will become second nature at some
point, but for now just think “smooth, blended, and polished.” When
you’re done, you’ll have a layer of perfect smoothness that you can then
blend back with your original layer to get the desired effect. Don’t forget
the neck area as well.

One of the great challenges, and most frequently asked questions, has

to do with figuring out from where to clone. Looking at the image through
the Green channel enables you to concentrate more on tone than color.
Find a clean area of skin with the same tone of gray and use this as your
cloning source.

When you’ve smoothed out all the rough spots, you can look at your
retouching layer by itself to see what areas you’ve retouched and also what
parts you may have missed. You should have a layer that looks something
like Image 12.

Looking at the image now, you may feel it’s flat or overdone. Well, you’re
right; it is! But don’t worry—you aren’t done quite yet. The trick is to get
back some of the skin’s original texture while retaining the smoothness you
have just created. Close the new window showing the Green channel and go
to the color one. In the Layers palette, select your retouching layer and
change its Opacity to 55%. Now you have skin texture back, with even
tone. (Yes, you can have your cake and eat it too!) The difference is subtle,



but subtlety is exactly what reality retouching is all about. As you can see
from Image 13, cutting back that bit of texture makes it look like flawless

real skin, not digitally smoothed skin.
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13 The effect of changing the opacity of the retouching layer.
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Perfect Eyebrows

Eyebrows! I do more work on eyebrows than you could possibly imagine.
They are extremely important because they frame the eyes and convey so
much of a face’s expression. Unruly, misshapen, fuzzy, or thin brows can
really detract from the appearance of an image. Unfortunately, because
real eyebrows are almost never perfect, they usually have to be fixed in
Photoshop. In this case, the brows were a little “unruly,” and the art
director wanted me to clean them up and change the shape a bit.

]

Beauty Retouching

14 The eyebrows before and after retouching.

To achieve this sharper, cleaner, more-finished brow, begin by removing
stray hairs with the Healing Brush. Next, use your Lasso tool (L key) to
grab a piece of skin from above the brow (see Image 15). Feather your selec-
tion by 4 pixels and copy the area, including all the retouch work, using the
Copy Merged command (Shift+Ctrl+C). Next, paste the selection into a new
layer and use the Move tool (letter V) to move it to cover unwanted brow,
as shown in Image 15.

Deselect (Ctrl+D) and soften the edges of your copied skin area using the
Eraser tool (brush size 60) at 50% Opacity. You can see that the top of the
brow line is much cleaner now, and you’ve achieved it without disturbing
the skin texture.

Continue this process across the entire top of the eyebrow to make a clean,
finished brow.




15 Selecting a piece of ekin above the brow and covering the unwanted brow
(removing stray eyebrow hairs).

Reality Retouching 105



106 Beauty Retouching

A Little Dentistry

Next, we whiten the teeth. This is a simple thing, but it makes the image
much more attractive. First choose your Magic Wand tool (letter W), set the
Tolerance to 25, and click the teeth to establish an initial selection. Next,
hold down the Shift key and continue clicking areas of teeth that were not
included in the initial selection, until all the teeth are part of the selection.

16 The selection for whitening the teeth.

To refine your selection, go to Quick Mask mode (letter Q) and use your
Paintbrush (letter B) tool to modify the mask. Remember, in Quick Mask
mode, painting in white removes masking from an area, adding it to your
selection, whereas painting in black adds in masking, removing areas from
your selection.

Now that you have a refined mask, feather the selection radius by 4 pixels
(Select > Feather) to give a nice blended edge.

Next, use the Levels control to adjust the whiteness of the teeth. Click the
model copy layer to activate it, and then open the Levels dialog box by
adding an adjustment layer (Layer > New Adjustment Layer > Levels), and
move the middle slider to the left a bit. Different amounts of whitening are
called for in every image, so use your own judgment and experiment until
it looks right to you.
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Happenin’ Hair

All right, now for one of my specialties...hair! As is often the case, I have
some areas that need hair added, and others that need hair removed. Let’s
start with the right side, where I am going to pop the model out of the
background, removing some hair and part of the shoulder in the process.
The hardest part of removing this background will be to keep the eyelashes
intact, because they stick out past the edge of the model’s face and are over-
lapping into the area I need to remove. When you attempt this, make sure
you are on the model copy layer. Then, begin by selecting large areas of the
background with the Magic Wand. After you’ve gotten most of the back-
ground selected, begin refining the mask in Quick Mask mode by using a
brush to clean up and define the edges that delineate the model from the
background. Good masks are the key to getting good edges! The longer you
spend in this mode refining the mask, the less work you’ll have later on.
Good masks are your friends!

After you’ve finished your mask, exit Quick Mask mode and feather the
selection by 2. Then save your painstakingly created selection. To do this,
click the layer mask icon at the bottom of the Layers palette. This creates a
layer mask from the selection. After you have converted your selection to

a layer mask, it will appear as a new alpha channel in the Channels palette.
This alpha channel of your selection enables you to further refine your mask
in the subsequent steps. Deselect the active selection, open the Channels
palette, and click the alpha channel you just created. This turns off all the
color, leaving you with a black-and-white silhouette of your mask. Any bits
and pieces you may have missed will now be easily visible, and you’ll be
able to go in with a white paintbrush and eliminate them. Also, because you
feathered the edge, you’ll want to go back and cut-in the mask around the
eyelashes with a small, fairly hard-edged paintbrush.

After you have perfected your mask, it’s time to pop the model out of the
background. Turn the RGB channel back on by clicking it in the Channels
palette. This activates and makes visible all the RGB color channels, and
deactivates and hides the alpha channel with your mask in it. The Channels
palette should now look like Image 24.
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24 The Channels palette
showing the alpha
channel deactivated.
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Next you need to turn your mask back into a selection. Ctrl+click the alpha
channel you created; marching ants outlining your selection should appear
in the image. Make sure your bottom “original” layer is hidden, activate
your model copy layer by clicking it, and press the backspace key. Voil4,
the background disappears (see Image 25)! You may still need to go in and
refine those lashes one more time, but everything else should be pretty good
right at this point.

Retouching hair is tricky because you can’t clone it, and healing it only
works in small areas. So here is my secret: I never retouch hair. I only copy,
paste, and transform. That’s the only way I have found to keep the texture
of the hair from getting muddy. In this example, the first thing you are
going to do is crop the image down. You need plenty of room on the right
for type anyway, and cropping will also leave you with less hair to fill in.

After you’ve cropped the image, you really only have a corner to deal with.
By luck of the draw, you also have one very nice piece of blonde hair that
looks like a good candidate for the copy/paste/transform technique. Select
that piece using the lasso, feather it by 5, and then use Copy > Paste (Ctrl+C
and Ctrl+V, respectively) to make a copy and paste it back into the file as a
new layer.

Now just move the pasted hair over to the left. Then, using the Free
Transform command (Ctrl+T), pull up and out on the upper-left corner and
rotate the selection slightly counterclockwise. The idea is to match the way
the hair is falling. After feathering out the edges with a soft brush, the hair
transplant should be virtually undetectable if done properly.

ADJUSTMENT LAYERS

Always use adjustment layers to make these
kinds of corrections; that way you don’t alter
any valuable pixels. If you don’t use an adjustment
layer, you lose the flexibility to change your mind
later. With adjustment layers, you can keep playing
with the settings without making any changes to
any of the pixels.

Adjustment layers will become your friends. The great
thing about changing things with adjustment layers
is that if the art director comes back and says “No,

it needs to be purple,” you already have your selec-

tion, and all you have to do is double-click to bring

the dialog box back up. This proves very useful given
how often art directors change their minds!



25 After deleting the masked-out hair 26 The selection of hair to copy and paste in.

27 The hair after pasting and transforming.
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Overall Look and Feel

Now that all the retouched elements are in place, you need to take a

final look at the overall appearance of the image. The image at this point
looks a little flat and a little dark, so you’re going to use an adjustment
layer to adjust the curves. First, make sure you are on the top layer of your
document so that the adjustment layer will affect all the layers below.
Then make an adjustment layer for the curves (Layer > New Adjustment
Layer > Curves).

Place the cursor over the image and click the image where you think the
tones look flat; you will see a small circle appear on the line in the dialog
box. This will give you an idea of where to grab the bar. Ctrl+click to mark
this spot. Pull up and down to lighten and darken. Play around here until
the image looks a little more bright and punchy.

A Few Final Touches

When you have it where you like it, take a break. Step back from the
computer, remove your hands from the keyboard...go look at a tree. You
need to get some distance so that you can tell whether you need to do any-
thing else. T often find things that the art director has missed. Why? Because
the art director hasn’t had the luxury of seeing it in this state, you have the
chance to see it before anyone else, and sometimes things will just jump out
at you. For instance, now that I have lightened the image considerably, I can
see that the lips need to be more pink and maybe a little more intense. I
remember when I shot this image the lip color was a little more vibrant.

So, what can I do? Well...it’s easy.

First you need to select the lips using the Polygon Lasso tool (see Image 28)
and feather by 2. When you have an active selection, the selection will
become a layer mask for your adjustment layer. This mask controls where
the subsequent effect shows up in the image. Now add an adjustment layer
for Selective Color (Layer > New Adjustment Layer > Selective Color) and
adjust the reds to the desired tone. I love Selective Color adjustment because
you can really change hues so subtly (see Image 29).



28 The selection around the lips.
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29 Using the Selective Color options to adjust the intensity of the lip color.
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All there is left to do now is paste in the background file. You need to
make your canvas larger to accommodate the final proportions. Enlarge the
canvas (Image > Canvas Size) to 11.5x13 inches, making sure you anchor
the image to the left side and to the top (see Image 30). Now open your
background file, and then copy and paste it into the final file. Make sure
that the new background layer is below the model copy layer, but above
your original layer.

ﬂ
— CurrentSize; 279M —————
idth: 8.02 inches
I-T:Iq::. 13.5 inches ﬂl
— New Size: 40M ——————————
width: 15 [inches =]
Heiht: [135 [inches =]
[~ Relative
Anchor f ﬂ
=
IR

20 Anchoring and resizing the canvas.

Your final should look like Image 31.

After you paste the background in, you may want to make a close-up
inspection of how the model image blends with the sky image just to
make sure that there are no rough spots that need further attention (see
Image 31).

Okay, so that’s it for reality retouching. Next, we’ll go on to plastic surgery,
which includes tips and tricks that build on the basics you’ve learned here.

31 Final image for reality retouch (opposite).
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Plastic Surgery

If, after you’ve finished the work of a reality retouching, more drastic work
is needed, you can move on to plastic surgery. First, do everything you can
to give the image a finished appearance. I don’t like to cut and paste parts
until the basics are done. Also, note that you can make dramatic changes

by stretching highlights and deepening shadows. This simple technique can
change the shape of a cheekbone or nose. When I do my initial retouching
layer, I pay close attention to the light and shadows. This becomes especially
important in some lighting conditions and with older models. You can
recontour someone’s face by widening and lessening shadows and highlights.
Pay close attention to where these shadows fall on the face, and how dark
they are, and you’ll be able to take years off someone’s face without needing
to change anything in the underlying structure.

When you open this file, it will already have a retouching layer in it. You’ll
clearly be able to see where the highlights and shadows have changed. T
have included this so that you can see exactly what this layer looks like. In a
soft yet dramatic lighting situation such as this one, there are shadows on
the right side of the face that do not enhance her face structure. I blended
the contours, took a little tuck in on the outer edge, and lightened the nose
shadow. If you turn the layer on and off, you will see the dramatic differ-
ence it makes in her overall appearance. Just this technique alone will take
years off. But wait...there’s much more.



32 Before and after plastic surgery collagen injection.
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Collagen Injections

With the initial retouching out of the way, it’s time to move on to the
surgery section of this image. Image 32 shows the before and after of reality
retouch with some additional plastic surgery. Unfortunately, the model’s lips
were not as full as the client wanted, so we’re going to work on them a bit,
removing some wrinkles and enlarging them.

To work on the lips, pop them into their own layer. Create a rough selection
around the lips, making sure you have a good amount of skin on the outside
as well (see Image 33). Feather it at about 5, and then use the Layer via
Copy command (Ctrl+]) to create a new layer from your selection. We’ll

do our work on the lips in this newly created layer.

The first thing to do with these lips is remove the wrinkle on the left side
of the lower lip with the Healing Brush. To do this, Alt+click above the
wrinkle to establish a sample point, and then click the wrinkle to heal one
small section at a time. To make the lips look fuller, continue to heal the
other wrinkles that go horizontally and vertically across the lip. Don’t
remove them all, but definitely eliminate the larger ones. Just removing
these wrinkles gives the lips an appearance of more fullness.



L

24 After using the Heal Brush on the lower lip.
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The next step is to adjust the shape of the lips. The shape in the original
image is good but a little bit thin. To fix the problem, use the Free
Transform command to stretch the layer ever so slightly.

Press Ctrl+T to launch the Free Transform command, and then, while hold-
ing down the Ctrl key, pull the center-top handle slightly up and to the left,
as shown in Image 35. This action increases the smirk a little and makes the
lips slightly fuller. You must reposition the lips slightly by using the arrow
keys to nudge the layer. Move them back down so that the upper lip on the
transformed top layer fits over the original. The following figure shows an
example of the new lip superimposed over the old.

As you can see from Image 36, the upper lip stays anchored in its original
position, and the bottom lip is now extending slightly below the original
lower lip.

Now that you have the new lip in place, you need to become a dentist for a
moment. Switch back to your original layer. Go in with the healing brush
and adjust the shape of the teeth, eliminating the gaps.

35 Transforming the shape of the lips to add fullnese.
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26 The transformed lips superimposed over the
untransformed lipe.

37 Areas to work on the teeth.
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586 Before and after work on the teeth.

Next, redden the lips. Choose your Polygon Lasso tool and draw an outline
of the lips. (Note that you also can use the Pen tool to make this selection.)
The outline here is critical because it will define the shape of the mouth and
the form of the lips, so take the time to make a really great selection, tweak-
ing where necessary to ensure the lips have a perfect shape.

After creating your selection, feather it by 4, and then add an adjustment
layer for Selective Color. Now you can begin to adjust the different colors.

I have made most of my adjustments to the red. You also can play around
with the neutral. Again, having these changes in an adjustment layer means
you can use a different color later if the art director requires changes.




39 The selection for adjusting lip color.
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Using the Selective Color options to redden the lips.
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The Eye-Lift

In this next image, we are going to fix the model’s right eye. Even though
this model is quite young and beautiful, her right eye appears smaller than
the left due to the angle of the shot. The task here is to transform it so that
the eyes look more even. First begin by lassoing the area around the model’s
right eye (see Image 43).

42 Before and after images of a plastic surgery eye-lift.
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43 Selecting and transforming the eye shape.
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Feather the selection by 35, and then use the Layer via Copy command to
create a new layer from your selection. Next enlarge the eye and lift the
eyebrow in one transformation by pulling the upper-left corner up, and

the lower-left corner out (see Image 43). After doing so, you must lower the
Opacity of the layer so that you can line up the transformed layer. Lowering
the Opacity enables you to see the two layers simultaneously. Line up the
new layer with the original so that the bottom of the eye on both layers is
in the same place. After placing it where you want it, reset the Opacity to
100%. Youw’ll probably have some cleanup to do on the outer edge. Get
your Eraser tool and, with an Opacity of 50%, use a large soft brush to
work the edges. This technique creates a flawless and invisible eye-lift.

As you can see in the final retouched image, the model’s right eye seems less
puffy and more symmetrical with the other. Even though this difference is
subtle, it gives a more fresh and appealing look.

44 The before and after of the final retouched image.
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The Nose Job

This next image was initially shot for stock, and was picked up by
Bombshell Studio Make-up (bombshellstudiomakeup.com) for their campaign.
Even though the model has stunning looks at certain angles, her nose
photographed unevenly. As with all of my images, I begin with the basic
retouching. After the standard smoothing and cleanup, using my mental

checklist as discussed earlier, I move on to the nose.

& o5

45 Before and after images of plastic surgery with a nose job.

46 Before the retouch, with notes on areas needing work.
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I first assess what work needs to be done. In Image 46, [ marked the parts
of the nose I wanted to see fixed in the final image. On the right side of the
model’s nose, I must add definition, because it isn’t clear where the bridge of
the nose is. I also need to lessen or remove the knob on the right side of the
model’s nose. Finally, I will reduce the width of the nostril on the right,
which will in turn lessen the nose’s overall width.

In this next image, I have done all the necessary retouching to the eyebrows,
lips, and skin. I also have lessened the shadow on the right side of the nose
using the Dodge tool and burnt the edge, using the Burn tool, with a very
small brush. The goal was to make the bridge more defined.

Now we will begin working on the right side of the model’s nose. Notice
that the basic retouching techniques—smoothing the skin, making the shad-
ows less dark—have already reduced the appearance of the knob on this
side, taking us halfway to the desired result.

Start on this side by copying the right half of the nose. Be sure to grab
enough skin on the right side—when you transform this, you’ll need the
extra to cover.

Feather the selection by 5 so that you have a smooth edge, and then create a
new layer from the selection.

, =

47 After the initial retouch, before plastic surgery.
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45  The selection for narrowing the nose.
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49 After transforming the nose.
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Next we’re going to free transform the shape of the right side of the nose
to lessen the overall width. We don’t really need to change much. Because
this is a small adjustment, make small changes until you have reached

the desired effect. First drag the right side of the transform box toward the
center. This action reduces the width of the nostril as well as the bridge of

¢ oA ore o the nose. When the width of the bridge looks good, drag the lower-right
! o P2 . . . .
! on it ‘N\d"“e‘:ayere 2 corner of the transform box in to further reduce the size of the nostril while
) 5V 4 . .
Whe wof\‘r‘“ on aNd .:\'\6 pefore a‘;‘; . leaving the width of the bridge the same.
2 e
awa¥? 7 509%% " et e _ _ .
feW ’00 e G\'\a";?:.\oo\d“g reﬂ:fwe Finish off the tip of the nose by creating a new, empty layer for retouching,
w .
ﬂ“":e ev ;\e ‘,aoeme‘;ﬂeo and then use the Clone tool to smooth out the bump on the tip.
%0 e ©
eV 2
) . . . , .
and ™ orormed ¥ The final step is to even out the nostrils. Because the model’s head is at an
angle, the nostrils appear to be two different sizes. I think the discrepancy
between the two is too large and needs to be a little more even. So first
!/
/
50 The selection for transforming the nostril.
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select the model’s right nostril, feather it by 3, and create a new layer from
the selection (Ctrl+]).

Free transform this new layer by holding down the Alt key while dragging
the handles to stretch and enlarge the nostril, paying close attention to angle
of the nose (see Image 51).

Now move on to the other side. Transform this nostril in the same way. This
time, however, just reduce the size ever so slightly.

As you can see when you compare the two images side by side in Image 52,
the difference is noticeable, but it’s unnoticeable if you don’t have the
original image as a reference point. Obviously, no one will have seen the
before, so the goal is to make a great-looking image regardless of where
you started.

3
o~

|
|

51 The transformation to enlarge the nostril.
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nd after the retouch.

52 Before a
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Xtreme Hair

I have one other item I want to show you in the plastic surgery category. It’s
not really plastic surgery, but more like a really big bottle of Rogaine. We’re
going to add heaps of hair!

5% The original shot before the hair extension treatment.

As you can see from Image 53, the model already has plenty of beautiful
hair. However, I want to add even more to get the “extreme hair” effect I
want in the final image.
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54  The final image with more hair.

I work with hair using three basic moves: Copy/Paste, Transform, and Twirl.
Let’s start by copying chunks of hair from other source images from the
shoot. Here are the three images to use as the hair transplant sources.
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55 The first hair transplant source image.

56 The second hair transplant source image.

Plastic Surdery 135



136

57 The third hair transplant source image.

Beauty Retouching

Select chunks of hair from the source images that will more or less match
the underlying hair in the target and fill out the shape and size desired. In
addition to the size and shape, look specifically at the lighting and color
tone. For example, notice the blue light hitting the model around the
hairline—you want to make sure that all the hair emanating from this area
has the same bluish cast. (Note that you also can use this technique by
copying from within the same image if you don’t have other sources to use.)

Believe it or not, this seemingly painstaking process is very forgiving. When
you feather the edges of the pasted selections, no one will really be able to
tell where one chunk starts and the other stops.

Image 58 shows a shot of the selection from the first source image. I grab
as much hair as possible from this shot because it will make up for a lot of
missing pieces in the original image. Also, it’s nice to get a lot of coverage
from one piece because it gives me less cleanup work to do.




58 The selection of the first chunk of hair for copying.

First, duplicate your background layer and turn the bottom one off. Then,
extend your canvas (Image > Canvas Size) so that you have room to work.
Anchor the image to the right side and create extra space on the left. Using
the Eyedropper tool, sample the color from the existing background, and fill
in the new background space using the Paint Bucket.

59 The target image with the first chunk of copied hair pasted in.
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After copying and pasting the selected hair into your file, you should have
something that looks like Image 59. Next you are going to copy a chunk for
the top portion of the hair from the second source image and paste it into

the file as well.

©0 The target image with the second chunk of hair pasted in.

As you can see from Image 60, this is not far off from where you want to be
eventually. Now you paste one more piece from the third source file and
begin the transforms and twirls.

61 The target image with the third chunk of hair pasted in.
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Now you twirl the ends of the hair to better match the existing hair and
give it a softer, more fluid effect. Using the Lasso, grab just the parts that
you want to change. Then use the Twirl filter (Filter > Distort > Twirl) to
add a slight swirl effect to the selected hair (see Images 62 and 63).

62 The image after some initial twirling, showing a selection for twirling.

I x|
S
Reset |

Angls |55| i

©3  The Twirl dialog box.
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Play with the Angle slider until the flow feels like that of the other pieces in
the image.

Your initial selection is key to how your final effect will appear. If you grab
a larger chunk of the same piece, you get a different effect when you twirl.

The last step is to free transform the shape of each piece you have pasted in.
Stretch, pull, and move the pasted fragment until it blends in with the flow
of the original hair. You’re not going for perfection, because you will touch
up in the next step. Instead, try to make the overall direction orientation
match the rest of the hair in the image. Use your original as the guide to
what the direction should be (see Image 64). Repeat this process for each

of the layers containing the fragments you have pasted in.

For final touch up, use the Erase tool to blend each piece into the back-
ground. Erase around the edges of your pasted-in piece until you find places
where the new hairs match up with those in the original hair layer below.

©4  Transforming the pasted fragment to fit.
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Fantasy retouching is my favorite kind of retouching. It’s basically the same
technique as the reality retouching except that it is designed to give a more
obviously enhanced, “painted-on” look. Whereas a reality retouch will go
undetected if done well, a fantasy retouch will be noticeable to all but the
most casual observers. Because fantasy retouching often goes hand in hand
with plastic surgery, I begin this section with an image that combines
fantasy retouching with a fair bit of plastic surgery.

Yummy Skin and Body Sculpting

I refer to this style of heavily retouched skin as “yummy skin.” When a
client asks for “yummy skin,” I know that texture is not important and that
the photograph is supposed to have a painted quality when it’s finished.

65 Before and after the skin retouching, with the retouch layer at 90% Opacity.
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Having read the preceding section on reality retouching, you will already
know the techniques used to accomplish this initial step. The only differ-
ences for a “fantasy” retouch are that the Opacity is set to 90% on the
retouch layer rather than 30% to 60% and that broader retouch strokes
are used over larger areas of skin.

As you can see from Image 65, a dramatic difference has been achieved with
retouching alone. Now let’s nip and tuck.

Nip and Tuck

You can give a little more definition to the model’s waist in two ways. First
copy a portion of the buttocks and create a new layer from the selection.
Then use the Spherize filter (Filter > Distort > Spherize). This pushes the
arch out to the right a little (see Image 66). You may need to erase around

PNES
Jnarg 49 the edges of your selection to blend the transformed area when the filter
2 29 g
eo\eo\,w\“:(:;“ered is complete.
2 wore ning ¥ . . .
cKI08 \\"’_Zi‘,v 299  Now add more curvature to the waistline by using the Clone Stamp tool,
k \3 : . -
\ oty o) kee};’bi& with the Use All Layers option checked, on this same layer and carefully
e it .
o ‘i,r:)?\e \)533 nyout  changing the shape. Use the tool to clone background over the unwanted
! na ¢ : : .
S0ttt rh areas, cutting-in the skin with the black background and carefully changing
ol )
o O the shape (see Image 67). Make sure to analyze the edge you are working
on, and use the right brush hardness accordingly.
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©6 Using the Spherize filter. 67  After epherizing and cutting in the waistline.
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The next step is to narrow the width of the waist. What are we going for
here? Well it’s pretty much up to you. I like curves in women—I have a few
myself—and so my preference is for a more curvaceous silhouette.

To start, grab a chunk of the left side with the Polygon Lasso. Then feather

by 2 and create a new layer from your selection.

The Shear filter is very handy for adding slight curves to just about any-
thing. I especially love this tool for the waistline. We are going to distort
this section of the waist so that it is more indented, giving it a little bit more
curve and shape. Use the Shear filter (Filter > Distort > Shear) by dragging
the center of the line slightly to the left, adding curvature to the waistline.

oK

x|
Reset
Defaults

—Undefined Areas: -
 \wrap Around
o

65 Using the Shear tool to add a curve to the waistline.

So here is where we’re at now.

As you can see from Image 69, the difference is quite dramatic. We have

made a big difference in just a few quick moves.
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At this point, I Save and then Save As under a new filename. I keep many
different versions of my files, creating a new one under a different name any
time I flatten something or make a change I may need to reverse someday.
Because you are going to flatten the image, this is a good place to begin on
another copy of the file.

Defining the Legs

Now define the legs even more by dodging and burning. Use the Dodge and
Burn tool to create more muscle definition on the thigh and calves. This will
give the leg a sleeker look. You must make sure your image is flat before
you do this, because you want the Burn/Dodge tool to be operating on all

©9 After shearing the left side of the waistline.
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your work to this point. Flatten (Layer > Flatten Image), and then make a
duplicate of your main layer as backup. Now, go to your top layer and
begin burning and dodging the highlights and shadows with the Burn/Dodge
tool to create more muscle definition (see Image 70).

The reason a copy layer is so important is that, after you’re done dodging
and burning, you may take a look and realize that you did a little too much
here and there. You can easily remedy this by using the Eraser tool on the
top layer. By altering the Opacity to adjust the intensity of any of the dodg-
ing and burning effects you have just done, you can get things just right.

70  After burning and dodging the leg muscles.
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A few last things are bothering me. First is the dip at the top of the
right thigh.

Grab a piece of the upper thigh, feather by 2, and create a new layer from
the selection. Free transform the selection by pulling up and out on its
upper-right corner. You need to rotate the selection a little counterclockwise
to make it match up. For final cleanup, touch up the edge of your selection
with a soft brush.

71 Transforming the shape of the back of the thigh.



The left side of the waist needs some work; I don’t think it curves in quite
enough. I will again grab a chunk of the waist and use the Shear tool as seen
in Image 72.

x|
oK
Cancel

Undefined Areas:
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" Repeat Edge Piels

72 Shearing the right side of the waistline.

You can grab the bar at different points to make just the right curve
and narrow her waist a bit. Again there should be minimal cleanup after
this step.
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7% Before and after of the fantasy retouch.

As you can see from image 73, all of these small changes make a big
difference in the overall shape of the body.

The secret behind what I refer to as fantasy retouching is the “painterly”
approach to the retouching itself, using long brush strokes with the Clone
Stamp tool. Because we are retouching on a Caucasian model, we also can
use the Green channel to our benefit when working.

Overall, the important thing to remember is that you will be blending tones
while doing large, flowing strokes. As opposed to reality retouching, where
you want to leave detail in the image, with fantasy retouching you are
obliterating the detail and going for smooth and “yummy” skin that looks
like it would be incredibly sleek and soft to the touch.

This chapter provides one more image from start to finish to give you
another example of the fantasy retouching style.



L’amour

Quite a lot has actually gone into this image. This section covers the major
steps so that you can get an idea of the workflow and the order in which
things were done. In this part, I also include information on how I created
her surroundings—even though this information goes beyond the “retouch-

ing” focus of this chapter.

74 Completed “Lamour” shot.
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75  Before the retouching.

Star Curtain
I began by putting the stars into the background. In preparation for this, I
took a shot of the set before we began shooting the model.

Using the Marquee, select a group of stars from the shot of the background
and copy them. Then, in your main image, use the Magic Wand to select the
background area where you’ll be inserting the extra stars. Use the Paste Into
command (Shift+Ctrl+V) to paste the copied stars into the background area
you have selected. Finally, free transform what you’ve inserted so that the
stars follow the pattern of their preexisting neighbors.

Repeat the star copying and pasting all the way across until you have
created a curtain along the back (see Image 78). I like to create a layer set
(Layer > New > Layer Set) for these parts just because it’s easier to work
with a file when things are organized as much as possible (see Image 79).
This will complete your background for the moment.



N
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79 Separate folder for
background layers.
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Retouching

Now it’s time to begin retouching. Begin as you did at the start of this
chapter, by opening two views: your normal window, which shows the full-
color image; and a Green channel window, which shows only the grayscale
view of the image’s Green channel (see Image 80). Your Channels palette
should look like Image 81.

81 The Channels palette with the
Green channel on.

82  During the blending process using in the Green channel.
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Image 82 shows the retouching in progress. Really work on creating even
blends from tone to tone. I find that if T click and drag in medium strokes,

I can create a beautiful and flawless skin tone. The shadows and highlights
can also be worked with at this stage to create more definition in the face.
To see the actual work you’ve done, view the retouching layer in isolation.
This will give you a look at the areas you’ve retouched and make it easier to
see whether you may have missed something.

/.
" o

. ’ *

83 The retouching layer viewed in isolation.

After you have retouched the model’s skin. The next thing to do is fix the
eye makeup. Notice, on the right eye, the prominence of the pearlescent
highlight of the eye shadow. I want to make the left eye just as pearly
and shiny.

&4  Selection of the eye shadow.
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To copy the highlight area from the right eye, make a selection using

the Lasso and feather the selection by about 10 (see Image 84). Copy the
selection into a new layer, and then flip it horizontally and move it over
the brow bone of the left eye. Adjust the pasted eye shadow using the Free

Transform command to fit it into its new space.

85 Fasting and transforming the eye shadow.

By turning on and off the layer you just created, you can check your work,
and hopefully see that the result is much more even than the original.

86 Before and after duplicating the eye shadow.

Now it’s time to do some dental work. Begin by smoothing the teeth and
blending the highlights using the Clone Stamp tool. Then select the leftmost
tooth and create a new layer from your selection.



Move and transform the pasted tooth to fit into the empty space on the
right side. Use the Levels command, moving the middle slider to the right,
to bring down the overall brightness of the tooth (see Image 88). Go back in
with your Clone Stamp to touch up the shape for a more uniform look (see

Image 8§9).

&7 Selection of the left tooth
for copying and pasting.

leves x| & Using the Levels command
— chamet[Fes ¥ : - to darken the tooth.
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89 After pasting and transform-
ing to create a new tooth on
the right.
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One other thing that makes the teeth look less straight is that the big
white highlight is only on the right tooth. If you copy, paste and blend that
highlight on the left tooth as well; this makes the teeth appear more even
(see Image 90).

Image 91 shows the current state of the Layers palette at this point.
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90 Before and after pasting and blending 91 Snapshot of the Layers palette
the highlights on the teeth. at this point.

As a final step, before working on the image as a whole, lighten the
eyebrows a bit.
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93 Using the Selective Color options to
92 The selection for lightening the eyebrows. lighten the eyebrows.
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First select the eyebrows and feather them by 5. Then use an adjustment
layer for Selective Color to go in and lighten the blacks. This way you leave
the light and midtone areas untouched and simply adjust the dark parts of
the brow to be a bit lighter.

As you can see from Image 94, the eyebrow adjustment is subtle but just

softens her noticeably.

94  Before and after lightening the eyebrows.

Final Enhancements
For some final adjustments, work the light and shadows with the Dodge and
Burn tool. These are very subtle yet very powerful tools.

94  Before and after dodging and burning to change light and shadows.
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It looks as if I have adjusted the whole image (see Image 94); in actuality,
however, I just dodged and burned key areas. I significantly lightened the
hair without changing any of the other tones. I also burned in the liner
around her eyes, her lipstick, and under her chin, but the eyebrows remain
light. T love this tool. It can really transform an image because it’s like
painting with light.

Warped Surroundings

The warped surroundings are all that’s left to be created to finish off the
image. First make a selection around the model, feather it by 50, and then
create a new layer from your selection.

95 A layer without the model.

The result should be a layer that looks something like Image 95. Next, I
used a KPTS filter called Radwarp, from Corel (see Image 96). This filter
does a great job of warping images—something that would take many
different native Photoshop filters to create.

You can see my settings in Image 96. I play with this until I have the feel ’'m
looking for.

You should get a layer that looks something like Image 97.



97 After the warp.

Notice how the warped image no longer covers the entire area; warping it
has made it smaller. You need to transform it and stretch it to fit the entire
area again. At this point, your image should look like something along the
lines of Image 98.
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Beauty Retouching

98 The original layer under the warped layer.

Okay, now what? Well, you need to combine the two backgrounds into one.
The easiest way to do that is to lower the Opacity of the new warped layer
to see where you need to blend and erase to make it work with the original

background.

99 Lowering the Opacity to see the layer underneath.



This gives you some idea of what needs to be done. You need to erase the
layer where it overlaps the model, as well as in other key areas, such as
the pink fur, that you may want to retain from the original.

To get back the original background, carefully erase between the star
curtains to reveal the original pink fur. This is a time-consuming part; it
takes patience, and you may have to go back if you make a mistake. Make
sure during this process that you keep putting the Opacity back to 100%
so that you can see how the blending and erasing are looking in the final

composite (see Image 100).

D

100  Erasing the warped layer.

After you have done this, you should end up with something like Image 101.

101 After uncovering the
background layer.
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103 The History palette,
showing snapshots used
for the History Brush.

Beauty Retouching

My final step is to flatten the image and add a little bit of blur. Everything is
a little too sharp, and I think adding blur will give it a more dreamy quality.
Open the History palette (Window > History) and make a new snapshot on
the History palette by selecting New Snapshot from the History palette’s
drop-down menu. Name the snapshot Final. Then run the Blur filter—I used
KPTS5 Blurrr filter, and chose the Gaussian Weave setting because it gives
that small crosshatch effect I was looking for (see Image 102).

Blur Types

Preview

Gaussian Weave

102 Using the KTFS Blurrr filter.

History Tool Prasets

~
p;i KPTS Blurrrr

ENERELE

Make another new snapshot on the History palette and name it Blur.

Then use the Step Backward menu command to step back one step in your
History palette. Click in the box to the left of your Blur snapshot to activate
it as the source for the History Brush (see Image 103), and choose the
History Brush from your Tool palette.

Now you can begin to paint with the blurred image, adding blur into
the image according to your individual taste. By varying the brush Size,
Hardness, and Opacity of the History Brush, you can vary the amount and



intensity of blur that gets added in. This is very much a thing of individual
taste, so it’s up to you where to use it and with how much intensity.

Image 104 shows the final image. I hope that breaking this down has given
you an idea how to achieve something like this in your own work. Arriving
at this image has definitely required a lot of steps, but the end result doesn’t
“look” like it.

104 Final image.

Where We Are

You have learned the degrees of retouching from reality to fantasy. Now
you are going to see some of these skills put into action. In the next three
chapters, I present three images and discuss what went into their creation.
I hope what you have learned in this chapter adds to your repertoire of
retouching and reconstruction techniques, and I hope the next few chapters
inspire you to create fantastic images of your own.
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